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Frequently Asked Questions 
 

Q: There is no communication between the LoadTrac-II and the PC.  What is going on? 
 
A: Check the Node ID’s: 
 
LoadTrac-II: 
 

 
 
 
On the TT.CU software program under Options > Hardware Setup, the Node ID’s must 

match. 
 
  
Q: When I view the system before starting the test, there are always about ± 0.005 kN 

(1 lb) load fluctuations. Why?  There is no contact between the vertical load cell and 
specimen, so why is there a small fluctuation in the load and how can I make it zero? 

 
A:  There is always going to be a small load fluctuation of about 0.025% of load cell full 

capacity, which translates into about 0.1 lb not 1 lb. 
 
To re-zero the load cell, please follow these steps: 
 
1. Go to the System Monitor, and record the analog reading of the vertical load cell 

when it is at the no load condition (when the load cell is not in contact with 
anything). 

2. Go to Calibrate Summary. 
3. Overwrite the Offset value for the vertical load cell with the analog reading value 

from step one. 
4. Click on the Apply and Ok buttons. 
5. You should now see in the System Monitor that the vertical load cell is virtually 

zero. 
 
*Note: This re-zeroing process can be applied to other sensors such as a pressure 

transducer. 
 
 
 
 
 
 
 
Q: What are the actual zero pressures for both the cell and the sample FlowTrac-II 

units at the beginning of a triaxial test? 

LoadTrac-II.    Rev. 40.04.0243       ID:65    
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A:  The pressure sensors are mounted on the triaxial cell; therefore any column of water 

inside the tubing up to the triaxial cell will be registered at the beginning of the test. This 
assumes that there are no air bubbles trapped inside the lines.  Conventionally, the zero 
pressure is the mid height of the soil sample in the triaxial cell when set onto the LoadTrac-II 
platen.   

 
To adjust for samples different heights, follow these steps for both the cell and sample 

pressure sensors: 
1. Disconnect the pressure sensor from the triaxial cell and connect them to a line 

filled with water. 
2. Raise the line to the location that corresponds to the mid-height of the soil sample, 

and zero the pressure following the above procedure (by placing the Offset value 
from the System Monitor into the Calibration Summary). 

 
 
Q: After running a successful test we ran into troubles with the report. We were not 

able to generate a report because all links on the report pull down menu are inactive. Are 
we missing something, or is the software not entirely installed? 

 
A: Once a test is finished or even while it is running, go to the File menu.  
 

1. Click on Load; this will load the test data on the open window on the desktop. 
2. Go back to Report. You should see now the Graph, Settings, and Edit menus all 

activated. 
3. You can change units and scales, and edit the test data points. 
4. Remember that every time you change or edit something, you will need to save 

the file, and load it again. 
 
Q: Do I need to use de-aerated water to fill the pressure panel; if so, how do I obtain 

de-aerated water? 
 
A: Yes, it is important to use de-aerated water to minimize air bubbles in the system, and 

speed up the back saturation process.  To prepare de-aerated water, boil water while 
applying a vacuum or use a device such as a Nold DeAerator, which combines propeller 
cavitations with a vacuum to de-aerate the water rapidly. 

 
 
Q: During the test, a controller error message appears on the screen telling me that a 

limit switch is on; what should I do? 
 
A: A possible cause is: 
 
The LoadTrac-II  limit switch has been triggered.  Lock the piston, manually move the 

platen, reapply the load from before the error message, unlock the piston, and click on the 
Retry button  

 
 
 
 



  TT-CU : MS User’s Manual                                                   ©2009 Geocomp Corp. 

    Geocomp Corporation  ·  1145 Massachusetts Avenue  ·  Boxborough, MA 01719 · Tel 978-635-0012  ·  Fax 978-635-0266 

 
 
Q: What are the area correction equations for uniform and parabolic? 
 
A: 

 

correctionareaparabolic:
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1

correctionareauniform:
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Q: We are having problems saturating a sample for C.U. Triaxial test. Our initial 

calculations from moisture content and density show the sample we are using to be at 
least 90% saturated. While monitoring the test gives a B factor that starts out at 0.15 and 
after running all night we have 0.65. Is this possible, and why? 

 
A: Is possible that if the lines are not fully flushed prior to starting a test. Air bubbles 

trapped in the lines and the specimen caps can drastically slow down the saturation process. 
 
 
 
 
Q: While the triaxial test is running, I noticed that my strain rate is slightly different 

than the one that I specified in the Shear Table. Why is that? How can I set it up 
correctly? 
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A: The difference in the strain rate between the specified one and the actual one can be 

attributed to the following: 
 
A.1 The vertical displacement sensor calibration may be off. Check the calibration factor 

and if necessary recalibrate the displacement sensor. 
 
A.2 The load step multiplier may need to be adjusted.  Assuming that the calibration 

factor for the displacement sensor is correct, and then follow these simple steps to adjust the 
load step multiplier: 

 

 Run the LoadTrac-II platen all the way down until it reaches the lower limit switch. 
Then move up until the displacement sensor reads about 20000 to 30000 counts. 

 Go to the View System Monitor and record both the pulse count for the Load motor 
and the displacement reading  

 Now move the platen up until the displacement reads 40000 to 50000 counts. 

 Again record both the pulse count and the displacement reading 

 Compute the load step multiplier as follows: 

 
 

 Adjust the load 
step multiplier 
accordingly by 

Load Step Multiplier = Δ Vertical travel /Δ Pulse count 
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going to Options HardwareStep multiplier 

 

 

 Note that the default value is 5.08e-005 mm/pulse count  (2.08e-006 in./pulse 
count) 

 
 
Q: Could the Node ID# for the LoadTrac-II change by itself? What possible reasons 

could you think to have prompted the change? 
 
A:  The default Node IDs for the LoadTrac-II is 65. If you are using different Node IDs, then 

if you reboot the system and by mistake press the ESC key on the keypad, the E-prom 
program reverts back to the default value. 

Just go back to the Setup menu  (refer to the LoadTrac-II hardware manual) and change 
the Node ID to the desired value (up to 256). 

 
 
Q.: We have a triaxial test running and an error message that reads:" Load reading of 

65528 is out of range” popped up.  Why does this show up and how do we prevent it? 
 
A: When you receive an error message stating, "Load reading of 65528 is out of range" it 

means that the load cell sensor has maxed out. Your sample strength is stronger than the 
capacity of the load cell. 

 
You will have to use a higher capacity load cell for this type of soil that you are testing. 
 
Right now, depending on how much the sample has strained: 
 
If the strain is a lot less than strain at failure (which depends on the soil type), you could 

restart the test again with a higher capacity load cell and make sure that you enter the 
corresponding calibration factors. 

 
If the strain is close to strain at failure, you may have to retest another sample with a 

higher capacity load cell.  
 
 
 
 
Q: We have several units connected to the same PC. We were running only one of the 

units, so we shut off the remaining units.  Then we got an error message stating that the 
unit was not responding. It seems that we lost communication with the unit. What is 
happening? 

 
A:  A temporary loss of communication is a normal thing when you either shut off or boot 

up another unit connected to the same network. Any time a unit connected to the network is 
powered down or powered up, the network goes into a re-configuration mode, during which 
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no communication is allowed. Depending on how many other units are on, this process may 
take some time. If you're lucky, the Windows software will miss it.  If you're not so lucky, you 
get the normal 'LoadTrac not responding' message. All you have to do is hit the Retry button 
and you should be all set. 

 
 
Q: I noticed that the engineering readings on the LCD screen are different than the 

ones on the PC screen.  Are they supposed to be the same? Did it affect the results of a 
test I just ran? 

 
A: SYNCHRONIZING LCD AND PC SCREENS: 
First, I would like to assure you that the mismatch of the engineering readings values 

between the LCD and the PC screens will not affect the results of any test that you have run 
through the PC software program. 

 
Assuming that your calibration factors are correct, or that you have just finished a new 

calibration and need to update the calibration parameters on the embedded controller of the 
LoadTrac-II or FlowTrac-II or the ShearTrac-II, you can synchronize the engineering readings 
between the LCD and the PC screen by following these steps: 

 
1. Go to the Calibrate Summary menu 

 

 
  
 

2. Select the sensor that you want to synchronize 
 

  
 
 

3. Click on the Download button. This will automatically transfer (copy and save) the 
current calibration parameters (Factor and Offset) into the embedded controller.  

 
 

4. Repeat the above procedure for the other sensors. 
 
You should now see that the PC and LCD screen values match. 
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Q: After an electrical power problem, it seems that the system is not working 

properly. We suspect that the set-up values on the embedded controller are not correct.  
How do we revert to the original set-up values or default values set at the factory? 

 
A: The default values may change either after an electrical power problem or due to 

inadvertent actions by the end user. 
 
You will need to revert back to the internal default values of your system by following 

these easy steps: 
 
1. Turn off the LoadTrac-II (or FlowTrac-II or ShearTrac-II) unit. 
2. Wait about 10 sec. 
3. Turn it back on and immediately press the ESC key on the keypad to reset everything 

back to the default values. 
4. You may have to manually reenter the Node ID number. (For example, the default 

value for the LoadTrac-II is 65.) 
 
 
Q:  Can the software detect wrong values that are manually entered by the end user? 
  
A: Yes, the software program detects any erroneous data entry; examples include: 
  
1. Negative values for sample dimensions, calibration factors, and PID control 

parameters 
2. Zero values for sample dimensions, calibration factors (except for offset value), 

and PID control parameters 
3. Wrong Node ID number 
4. A malfunctioning sensor that it is giving an analog reading of either 0 (the 

minimum value) or 65535 (the maximum value) 
5. Any unit (LoadTrac-II or FlowTrac-II) that is not on. 
 
 
Q: I am running a test. Do I need to wait until the end of the test to see the results? 
  
A: You do not need to wait until the end of the test.  While the test is running: 
 
1. Go to the File menu. 
2. Select Load. 
3. Go to the Report menu.  You should now be able to see the partial data up to the 

point when you did the Load. 
4. Repeat the above steps as the test progresses. 
 
 
Q: In many of our different test files, the calibration values in the Summary Table and 

the values in each sensor's individual calibration table are not in sync.  Could you please 
explain which values the program uses, and how to make sure they are correct?   
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A:  All of the Geocomp control programs have similar menus for performing the calibration 
of any of the sensors related to the test.  However, you must then copy the calibration that 
you obtained into the Summary Table.  (If you have had to repeat the calibration procedure, 
be sure to use the correct value.) 

 
The calibration factors in the Summary Table are the ones that the particular program 

uses when running a test. 
  
Note that it is possible to have no calibration data in the calibration menu if you calibrate 

a sensor with one program (for example, TT.CU) and later use a different program (for 
example, ICON): Each program will always uses the calibration factors contained in its 
Summary Table. 

 
 
Q: I have a question about graphing the results of a CU test.   Triaxial reports have the 

option of graphing either max shear or max obliquity. Could you explain the difference 
and why you'd report one instead of the other.  Up to now, we have been reporting max 
obliquity for each report. 

 
A: You should use the maximum obliquity for CU tests, and maximum shear for CD tests. 
 
The failure condition may be defined as: 
 
1. Maximum principal stress difference, ( σ1- σ3) max 
2. Maximum principal effective stress ratio ( σ1’ / σ3’) max 
3. Shear Stress = ( σ1- σ3) /2  at a prescribed strain 
 
 
Q: Before starting the test I noticed some air bubbles in the drainage-backpressure 

tubes. Is there any way to saturate the tubing once the sample is in the cell and the cell is 
full of water (in order to save time)? 

 
A: Yes, by slowly opening the far right valve (one of the two top drainage lines) to get rid 

of the remaining air bubbles. 
 
Q: Why is the displacement value shown on the System Monitor screen different that 

the one shown in the Test Monitor screen? 
 
A: In all Geocomp software programs, the displacement reading is automatically zeroed at 

the start of the test; therefore, the offset value in the calibration summary for the 
displacement sensor is irrelevant. 

Also, as a result, the System Monitor (non-zeroed value) will show a different value for the 
displacement from the Test Monitor (zeroed value). That is totally normal and expected. 

 
The reported value should match the Test Monitor value unless further corrections (such 

as machine compressibility) are involved. 
  
 
Q: How do you delete a bad point at the completion of a test? 
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A: First, find out if it is really a bad data point (due to an electrical power surge or any 
other cause).  

If such is the case, follow these simple steps: 
  

1. Go to the Report menu.  
2. Select Edit. 
3. Locate the bad point 
4. Use the mouse to position the arrow in the first column of the row that you wish to 

delete.  
5. Right click on the mouse. You should see a small window with the choices Delete 

and Insert. 
6. Click on Delete. The row with the bad point will be deleted. 
7. Use Save As to save the file with a new name.  

 
Always keep the original test file intact. 
  
  
Q: When I start a test, the program gives me an error message stating that the 

calibration factor is too small.  I cannot run the test.  
 
I checked the Calibration Summary table. All values for the calibration factors are 

there; however, the displacement sensor calibration factor has a negative sign. What’s 
wrong? 

 
A: The software does not accept zeros or negative numbers for the calibration factors in 

the Calibration Summary.  For convenience, we run the calibration on the displacement 
sensor backwards, hence the negative sign for the calibration factor. Remove the negative 
sign and you should be all set. 

 
 
Q: When setting up our LoadTrac-II system this morning, I noticed that the plastic load 

cell now contains thousands of tiny hairline cracks, mostly around the middle, but some 
on the ends also. 

 
A: This is very common. When acrylic sheet is made, it is normally cast, and the thickened 

monomer polymerizes between two sheets of glass. The shrinkage on polymerization is 
significant (>10%), and as a result internal stresses are built in to the sheet.  When the sheet 
is cut to manufacture a box or frame, etc., then the internal stress is relieved at the point of 
the cut but still remains in the rest of the sheet. Any slight imperfection on the surface will 
cause a localized concentration of those stresses, and the sheet could then start to crack at 
that point. In practical terms this is not normally a problem unless the sheet is exposed to an 
aggressive environment. UV from outdoor exposure over a long time (normally years rather 
than days) will cause surface cracks to appear as the stress is relieved. These appear as 
crazing on the surface. The most common occurrence in the laboratory is when the sheet is 
exposed to non-polar solvents as vapors. 

 
 
Q: The following error message when the shear phase is running: "LoadTrac ID 65 load 

reading of 65528 is out of range".  What does it mean? Is it something related to the 
platen position?  
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A: It means that the load cell sensor has reached its maximum. The software program has 

built-in safety features to shut down the test when any of the sensors is reading either the 
minimum or the maximum analog reading (count reading), which ranges from 0-65535. 

The load cell sensor maxes out if the sample is too stiff, or if the piston was left unlocked. 
 
 
 
Q: The stress strain curves for my triaxial test looks wavy with negative values. I am 

testing a very soft soil. Is there something wrong that I am doing? 
 
A: If your graph looks like this: 
 

 
  
 
It is actually typical of very soft soils, as the rolling effect of the membrane creates this 

rippling pattern. The strength is gained by each rolling step. See attached picture 
 
  The negative values can be explained by the fact that the membrane stiffness correction 

is higher that the soil strength itself. If you zero the membrane stiffness correction your graph 
will be positive and looks more like this: 
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Q. What is the expected excess pore 
pressure during an undrained shear of 
 granular soil? 

 
A. Please refer to attached typical 
diagram of excess pore water pressure 
behavior during an undrained shear 
phase of a triaxial test.  
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Q. What is the purpose of the filter paper? Are these strips supposed to be in contact with 
the top and bottom stones?  

 
A. Filter paper is used for two purposes: 

1. To speed up the consolidation process by providing radial out drainage. 
2. To help pore pressure equalization over the length of the sample during both 

backpressure saturation and undrained shear phases. 
 
Yes, it would be beneficial that the filter paper strip touch the porous stones for the above 
reasons. Below is a good reference on the above subject. 
 

 
 
 
Q. It seems that  no matter what we do we can never achieve 0.95 B value during the 
saturation. We used  the carbon dioxide flushing method, we  increase the time intervals 
in the saturation table. Is there anything else that we should try? 
 
 

Titre du document / Document title 
Influence of filter paper and leakage on triaxial testing  

Auteur(s) / Author(s) 
LEROUEIL Serge ; TAVENAS Francois ; LA ROCHELLE Pierre ; TREMBLAY Michel ;  
Résumé / Abstract 

A significant problem, especially in long-term tests, is leakage through the fittings and membrane. To avoid the first of 
these two sources of error, a cell with fittings enclosed in a back pressure chamber has been developed. To reduce 
leakage through the membrane, various cell fluids have been considered and tested in normal triaxial test conditions 
but with a dummy in place of the specimen. The results show that silicone oil minimizes the leakage. Filter papers are 
used in triaxial testing to accelerate the consolidation process and the equalization of effective stresses within the 
specimen during shearing. The drainage capacity of five different filter papers was measured, and their effect on the 
consolidation and shear processes was evaluated by comparative tests. The results show that in the 
overconsolidated range, the filter papers are efficient; however, due to the high coefficient of consolidation of natural 
clays in this range, they are not really useful. In the normally consolidated range, the efficiency of the filter drains 
during consolidation is considerably less than expected; contrary to what has been observed by other researchers, no 
effect of the filter drains on shear strength was found.  

Revue / Journal Title 
ASTM special technical publication  (ASTM spec. tech. publ.)  ISSN 0066-0558   

Source / Source 

1988, n
o
977, pp. 189-201 [13 page(s) (article)] 
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A.  You may never get a B value of 0.95 because of the soil type that you are testing and its 
initial degree of saturation. See below Table. 
 
Theoretical B-Values for Different Soils at  

Complete or nearly complete saturation* 
 

Soil Type S=100% S=99% 

Soft, normally  
Consolidated clays 

0.9998 0.986 

Compacted silts and clays; 
lightly over consolidated 
clays 

0.9988 0.930 

Overconsolidated stiff 
clays; sands at most 
densities 

0.9877 0.51 

Very dense sands; very stiff 
clays at high confining 
pressures 

0.9130 0.10 

 
*After Black and Lee (1973) 
 
 

BLACK,D.K., AND  LEE,  K.L.(1973)”Saturating Laboratory Samples by Back Pressure.” 
Journal of the Soil Mechanics and Foundations Division,ASCE, Vol.99,No.SM1,pp.75-93 

 
Furthermore ASTM  D4767, Section 8.2.3:”Specimens shall be considered to be saturated if 
the value of B is equal to or greater than 0.95, or if B remains unchanged with addition of 
back pressure increments.” 
 
 
 
 
Q. I used our calibrated gauge blocks to check our displacement sensor on the load 
frame.  It appears to give readings roughly one half the actual distances.  I double 
checked that the calibration factor (in/cnt) from the certificate you gave us is in both the 
load frame and the software (factor = 3.6498841x10-5).  Does this factor seem to be off 
by a factor of two, based on the other similar sensors you have calibrated? 
 
A.  The displacement sensor set-up in the LoadTrac-II must be reset to UNIPOLAR instead of 
BIPOLAR. Please follow these easy steps to change it: 
 

 Using the keypap and the LCD screen go to option 4. SETUP 
 

 
 

LoadTrac II. Rev. Year.Month.Day    ID 65. 
1. Monitor   4. Setup 
2. Position   
3. Control 
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 Option 3: A/D setup 

 Option 2: Channel 2 

 Option 2: Polarity 

 Select Unipolar 
 
Next turn off the LoadTrac-II and back on for the changes to take effect. 
 
 
Q. Can I use a new calibration factor and apply it to the previous test I have already ran 
and get the correct results? 
 
A. Yes, you can. 
 
Q. Is there a shear rate that you recommend for a CU Triaxial test ? 
 
 A. The shear rate is calculated according to ASTM D 4767 Section 8.4.2 as follow: 
Either assume the strain at failure as 4% or use your judgment based on the soil sample as a 
general rule of thumb use the attached table recommended values/  
 Compute t50 from the consolidation data use the excel template.. 
  Shear strain rate is: 
 
Strain rate (%/min)  = Strain at failure / 10 x t50 
 
 
TRIAXIAL CU TEST 
 
Recommended Strain Rates  in %/min. 
 
 

SAND Very Dense Dense Medium Loose Very Loose 

CLAY Very Stiff Stiff Medium Soft Very soft  
(plastic) 

Strain at  
Failure (%) 

f 

 
 1% 

 
 2% 

 
 4% 

 
8% 

 
15% 

T50, min. 
 
 
0.5 
1.0 
5.0 
10 
20 
30 
60 
 
 

 
 
 
0.2 
0.1 
0.02 
0.01 
0.005 
0.0034 
0.0017 

 
 
 
0.4 
0.2 
0.04 
0.02 
0.01 
0.007 
0.0035 

 
 
 
0.8 
0.4 
0.08 
0.04 
0.02 
0.015 
0.007 

 
 
 
0.18 
0.8 
0.16 
0.08 
0.04 
0.03 
0.015 

 
 
 
0.34 
1.5 
0.3 
0.15 
0.075 
0.05 
0.025 

 
 

Shear Rate (%/min.)=   f / [10 x T50]  
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Example:   Dense sand with a T50 (time for 50% primary consolidation) equals 1 min. 

From Table f = 1% and shear rate = 0.1 % /min. 
 
Important Note: USE  SAME STRAIN  RATE FOR A SERIES OF THREE TESTS  
 
 
Q. The Network LED’s are RED on the front panel and there is no communication between 
the PC and the frame, all of our ID numbers are correct, what else should we check? 
 
A. The network communication cable (gray cable) must be plugged into the Ethernet plug on 
the back of the PC instead of the network communication card that we provided. Please 
unplug the cable and replug into the card. The LED’s should turn into solid green. 
 
 
 

 
 
 
 

 To LoadTrac_II 
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Q. How can we obtain the failure envelope after performing a series of tests  
on the same soil sample? 
 

A. If you have run a series of tests with different confining stresses under different 
filenames, then you need to use the companion 
editing/reporting software (TT.CU.report.exe) to 
combine up to four tests and generate failure 
envelope. Once the program is open  go to File and 
load the first test then go to Window  click on 2, 
back to File and load second  test file, repeat  for 
remaining test files. 

 
 
Q. Is it possible to view the data and graphs while a test is in progress? 
 
A. Yes, while the test is running go to: 

File  Load then 
Report Graph or Table  

to view partial data and graph up to the moment when you load the file. Repeat the above 
step to update data and graphs. 
 
 
Q.  Why there is a difference between the specified and the applied displacement rate? 
  
A. The difference between the specified displacement rate and the applied one may be due 
to any of the following: 
 

1. Wrong displacement calibration factor. Should be around 5x10^-5 in/count. 
2. Wrong step factor. Should be about 2.1x10-6 in/step (under Options/Hardware/Load 

Step multiplier). 

Terminator 

 To PC 
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3. Polarity of the displacement sensor. Should be unipolar for Novotecnik sensor (with 
square cross section). 

 


